
  

 

 

KÄSKKIRI   
 23. aprill 2024 nr 1-2/18 
  
Innovatsioonilabori kasutamine  
 
Tallinna Linnavolikogu 18. oktoobri 2007. a määruse nr 31 „Tallinna Keskraamatukogu 
põhimäärus“ § 6 lõike 2 punkti 5 ja Tallinna Linnavolikogu 2. juuni 2016. a määruse nr 19 
“Tallinna Keskraamatukogu kasutamise eeskiri“ § 1 lõike 4 alusel  

 
1 Üldsätted  

1.1 Käskkiri „Innovatsioonilabori kasutamine“ (edaspidi käskkiri) reguleerib innovat-
sioonilabori kasutamist ning selle kasutaja vastutust ja kohustusi. Käskkirjas sätes-
tamata nõuded ja tingimused on sätestatud “Tallinna Keskraamatukogu kasutamise 
eeskirjas“.  

1.2 Käskkirjas kasutatakse mõisteid järgmises tähenduses:  

1.2.1 raamatukogu on Tallinna Keskraamatukogu;  

1.2.2 innovatsioonilabor on Kännukuke raamatukogus aadressil E. Vilde tee 72 asuv 
innovatsioonilabor; 

1.2.3 lugeja on Tallinna Keskraamatukogu lugeja;  

1.2.4 kasutaja on lugeja, kes kasutab innovatsioonilaborit; 

1.2.5 alaealine on 12‒17-aastane raamatukogu lugeja; 

1.2.6 vanem on alaealise seaduslik esindaja (hooldusõiguslik vanem või eestkostja); 

1.2.7 juhend on innovatsioonilabori seadmete kasutus- ja ohutusjuhend;  

1.2.8 seade või seadmed on innovatsioonilaboris kasutajale kasutamiseks olevad 
innovatsioonilabori seadmed.  

1.3 Innovatsioonilaborit saab kasutada lugeja, kel on kehtiv raamatukogu kasutamise 
õigus.  

1.4 Alaealine lugeja saab kasutada innovatsioonilaborit, kui vanem on andnud selleks 
nõusoleku vormil „Nõusolek raamatukogu kasutamiseks.“ Alla 12-aastane lugeja võib 
innovatsioonilaborit kasutada vaid täisealise kasutaja, kes vastutab innovat-
sioonilabori seadmete kasutamise eest, juuresolekul.  

1.5 Innovatsioonilabori kasutamine on tasuta. Kasutajal tuleb tasuda materjali(de) eest  
vastavalt hinnakirjale. Materjalide eest ei pea tasuma: 
1.5.1 raamatukogu korraldatud innovatsioonilaborit tutvustaval koolitusel või 

üritusel osalejad;  
1.5.2 juhul, kui kasutaja kasutab isiklikke materjale. Isiklike materjalide kasutamine 

tuleb eelnevalt raamatukoguhoidjaga kooskõlastada, et oleks tagatud mater-
jalide sobivus seadme(te)le. 

1.6 Seadmeid võib kasutada ainult raamatukogus kohapeal. 
1.7 Seadmeid ja materjale võib kasutada ainult isiklikuks otstarbeks, mitte äriliseks 

tegevuseks. 
1.8 Innovatsioonilabori seadme(te) kasutamisel tekkivatest probleemidest tuleb 

kasutajal viivitamatult teavitada raamatukoguhoidjat. 

https://www.riigiteataja.ee/akt/429122020061?leiaKehtiv
https://www.riigiteataja.ee/akt/429122020061?leiaKehtiv
https://www.riigiteataja.ee/akt/429122020059?leiaKehtiv
https://www.riigiteataja.ee/akt/429122020059?leiaKehtiv
https://www.riigiteataja.ee/akt/429122020059?leiaKehtiv
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1.9 Raamatukogu ei vastuta kasutaja isiklike asjade eest, mis kasutaja on unustanud 
innovatsioonilaborisse.  

 
2 Innovatsioonilabori kasutamine 

2.1 Enne innovatsioonilabori kasutamist on lugeja kohustatud tutvuma käskkirjaga ja 
juhendiga (lisa 1) ning läbima koolituse, mille käigus raamatukoguhoidja tutvustab 
seadme(te) kasutamist. Innovatsioonilabori kasutamiseks on vajalik inno-
vatsioonilabori seadme(te) kasutamise oskus. Innovatsioonilaboris on järgmised 
seadmed: 

 Seadme nimetus Soetushind 
eurodes 

2.1.1 Printer-kilelõikur  7320,00 

2.1.2 3D-printeri komplekt 
Ultimaker S3 

4167,00 

2.1.3 3D-printeri komplekt 
Ultimaker 2+ 

2441,00 

2.1.4 Graafikalaud 1883,00 

2.1.5 Kilelõikur 1860,00 

2.1.6 Laserlõikepink 4740,00 

2.1.7 Lõike- ja pressimismasin 169,00 

2.1.8 Märgipress 330,00 

2.1.9 Termopress 600,00 

2.1.10 Virtuaalse reaalsuse prillid 535,00 

2.1.11 Fotoaparaat/filmikaamera 935,30 

 

2.2 Innovatsioonilabori kasutamiseks tuleb kasutajal esitada lugejakaart või lugeja-
kaardiks vormistatud ID-kaart iga kord enne innovatsioonilabori kasutamist. 
Lugejakaardi/ID-kaardi esitamisega kinnitab lugeja, et on käskkirjaga ja juhendiga 
tutvunud ning kohustub neid täitma. Lugejate andmebaasis märgitakse lugeja 
innovatsioonilabori kasutajaks.  

2.3 Seadme(te) kasutamiseks tuleb broneerida aeg, mida saab teha raamatukogus 
kohapeal või helistades telefonil 683 0951 või saates e-kirja aadressil 
kannukuke@tln.lib.ee. Raamatukogu teavitab lugejat, kui innovatsioonilabori 
kasutamiseks on talle aeg broneeritud.  

2.4 Raamatukogul on nõudluse reguleerimiseks õigus määrata, mitmeks tunniks 
maksimaalselt on võimalik seadme(te) kasutamiseks aega broneerida.  

2.5 Raamatukogul on õigus broneering tühistada, kui kasutaja on hilinenud üle 10 minuti 
arvates broneeringu algusest. 

2.6 Kui seade on vaba ja raamatukogu töökorraldus seda võimaldab, saab seda kasutada 
ka ilma eelneva broneeringuta. 

2.7 Raamatukoguhoidjat tuleb teavitada, kui seadme kasutamine on lõpetatud. 
2.8 Raamatukoguhoidja käest saadud seadmed, juhtmed jms, tuleb peale kasutamist 

tagastada raamatukoguhoidja kätte. 
2.9 Seadmete vahetus läheduses on söömine ja joomine keelatud.  

 
3 Innovatsioonilabori kasutaja vastutus ja kohustused 

3.1 Kasutaja kannab varalist vastutust tema kasutusse antud seadme(te) eest. 
3.2 Kasutaja on kohustatud järgima käskkirja ja juhendit (lisa 1).  
3.3 Seadme(te) kasutamise lõpetamisel on kasutaja kohustatud: 

3.3.1 korrastama töökoha; 
3.3.2 võtma kaasa enda isiklikud asjad; 

mailto:kannukuke@tln.lib.ee


 3 

3.3.3 tekkinud väiksemad olmejäätmed viskama innovatsioonilaboris olevasse 
olmejäätmete prügikasti, muu tekkinud prügi kaasa võtma; 

3.3.4 teavitama töö lõpetamisest raamatukoguhoidjat; 
3.3.5 koos raamatukoguhoidjaga innovatsioonilabori üle vaatama.  

3.4 Autoriõigusega kaitstud mudelite, kujundite, piltide jne seadusliku kasutamise eest 
vastutab kasutaja. 

3.5 Kasutaja on kohustatud raamatukoguhoidjale viivitamata teada andma seadme 
kasutamisel ilmnenud seadme defektidest või seadme rikkumisest. 

3.6 Seadme rikkumise kahtluse korral teostab raamatukogu 30 päeva jooksul seadme 
tehnilise korrasoleku kontrolli, vajadusel kaasates ekspertiisi teostamiseks 
kolmandaid isikuid. Kui tuvastatakse seadme rikkumine, millest kasutaja ei ole 
raamatukogu teavitanud, võtab raamatukogu kasutajaga ühendust. Kasutaja on 
kohustatud tasuma rikutud seadme ekspertiisi- ja remondikulud. 

3.7 Kui rikutud seadet ei ole võimalik parandada, on kasutaja kohustatud tasuma 
raamatukogule selle soetushinna.  

3.8 Alla 18-aastase isiku tekitatud kahju hüvitab vanem. 
3.9 Raamatukogu annab kasutajale tähtpäeva punktide 3.6 ja 3.7 kohaselt arvestatud 

võla tasumiseks. 
3.10 Kui kasutaja raamatukogu antud tähtpäevaks võlga ei tasu, annab raamatukogu 

võlgniku, alla 18-aastase isiku puhul vanema, isikuandmed ja võlaandmed üle 
krediidiinfo teenuse osutajale võla raamatukogule sissenõudmiseks. 

3.11 Raamatukogul on õigus määrata kasutajale, kes ei ole järginud käskkirja või juhendit 
või on rikkunud seadet või raamatukogu inventari, määramata ajaks innovat-
sioonilabori kasutamise keeld.  
 

4 Käskkirja teatavaks tegemine 
4.1 Sekretäril teha käskkiri teatavaks teenindusdirektorile, teenindusdirektoril Kännu-

kuke raamatukogu töötajatele. 
4.2 Veebihalduril avalikustada käskkiri raamatukogu veebilehel, sekretäril siseveebis. 

 
5 Kehtetuks tunnistamine  

5.1 Tunnistada kehtetuks direktori 20. juuli 2022. a käskkiri nr 1-2 /30 „Innovat-
sioonilabori kasutamine“. 

 
 

 
(allkirjastatud digitaalselt) 
Kaie Holm 
direktor 
 
Lisa 1 Innovatsioonilabori seadmete kasutus- ja ohutusjuhend  
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23. aprilli 2024. a käskkirja nr 1-2/18 
„Innovatsioonilabori kasutamine“ 

lisa 1 
 
Innovatsioonilabori seadmete kasutus- ja ohutusjuhend 
 
1 3D-printeri kasutamine 

1.1 3D-printeri kasutamiseks on vajalik osata kasutada arvutitarkvara Cura (vabavaraline 
programm), seejärel valida sobiv materjal (saab osta raamatukogust) ja mudel ning 
siis printida.  

1.2 Raamatukogus programmiga Cura töötamiseks tuleb broneerida innovatsioonilabori 
arvuti, kuhu on arvutitarkvara Cura juba installeeritud.  

1.3 Arvutitarkvara Cura kasutamine 
1.3.1 3D-mudeleid on võimalik arvutisse alla laadida erinevatelt 3D mudeleid 

pakkuvatelt vabavaralistelt veebilehtedelt. Mudeli printimiseks tuleb see 
laadida arvutitarkvarasse Cura (edaspidi Cura). Selleks tuleb avada arvuti 
töölaualt Cura, klõpsata Open File ja valida arvutisse salvestatud mudel.  

1.3.2 Vasakpoolses menüüs on võimalik muuta mudeli asukohta, suurust ning seda 
pöörata. 

1.3.3 Ülaservas olevast menüüst on võimalik valida printerit, filamendi materjali ning 
avada paremal servas asuv menüü erinevate printimise lisavõimalustega. 

1.3.4 Režiimi valimise ja seadete muutmise järel jagab Cura mudeli kihtideks. Seejärel 
on võimalik vaadata, kui kaua 3D-printer orienteeruvalt mudelit prindib ning 
mitu grammi materjali mudeli printimiseks kulub. Tasu materjalikulu eest 
arvestatakse vastavalt hinnakirjale. 

1.3.5 Enne faili salvestamist ja printimist on soovitatav vaadata mudel üle kihilises 
vaates (Layers View), et leida üles võimalikud mudeli vead. Kihiline vaade kuvab 
eelvaate prinditavast mudelist, kus on näha, mida printima hakatakse. Kihilise 
vaate avamiseks tuleb vajutada View Mode nupule vasakpoolses menüüs ja 
seejärel valida Layers. 

1.3.6 Faili salvestamiseks tuleb arvutisse sisestada mäluseade, 3D printer Ultimaker 
2+ puhul SD-kaart (mälukaart) ja Ultimaker S3 puhul mälupulk, mille saab 
raamatukoguhoidja käest. Pärast mäluseadme  arvutisse sisestamist tekib Cura 
alla paremasse nurka nupp Save to Removable Drive, millele vajutades 
salvestub fail mäluseadmele. Pärast faili salvestamist mäluseadmele tuleb 
mäluseade turvaliselt arvutist eemaldada (Eject).  

1.3.7 Põhjalik Cura kasutusjuhend inglise keeles on kättesaadav veebilehel  
https://support.ultimaker.com/hc/en-us/sections/360003548339-Ultimaker-
Cura . 

1.4 3D-printeriga mudeli printimine 
1.4.1  Mäluseadmele salvestatud mudeli printimiseks tuleb  mäluseade sisestada 3D-

printerisse.  Mäluseadme pesa on 3D-printeri esipaneelil ekraani kõrval vasakul. 
1.4.2 3D-printeri esiplaneeli ekraani menüüs tuleb printimiseks valida Print ja seejärel 

valida fail, mida soovitakse printida. 
1.4.3 3D-printimiseks kasutatavat materjali nimetatakse filamendiks. 

Innovatsioonilaboris on kasutamiseks PLA ja TPU 95A filament.  
1.4.4 Kui 3D-printer on printimise lõpetanud, tuleb objektil lasta jahtuda vähemalt viis 

minutit. Kui objekt on jahtunud, võib selle klaasilt eemaldada. 
1.4.4.1 Kui jahtunud objekt on 3D-printeri klaasi küljes kinni ja seda ei õnnestu 

eemaldada, tuleb 3D-printeri kasutajal pöörduda abi saamiseks 
raamatukoguhoidja poole.  
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1.4.5 3D-printeri kasutamise lõpetamisel tuleb SD-kaart, mälupulk vm raamatukogult 
laenatud mäluseade raamatukoguhoidjale tagastada. 

1.5 Ohutusnõuded 
1.5.1 3D-printeri kasutamine on keelatud ilma eelneva raamatukogupoolse 

koolituseta. 
1.5.2 3D-printer töötab väga kõrgel temperatuuril (3D-printeri otsiku temperatuur 

võib tõusta kuni 260°C, klaasi temperatuur võib tõusta kuni 120°C) ja sellel on 
kuumad liikuvad osad, mis võivad tekitada vigastusi. 3D-printeri soojenemise, 
printimise ja jahtumise ajal ei tohi 3D-printeri printimisala ja liikuvaid osasid 
puutuda.  

1.5.3 Sulanud filamendi gaase sisse hinganud inimene tuleb esimesel võimalusel viia 
värske õhu kätte, vajadusel konsulteerida arstiga. 

1.5.4 Põletuse korral tuleb koheselt pöörduda arsti poole.  
1.5.5 Kokkupuutel sulanud filamendiga tuleb naha külge kinni jäänud materjal 

võimalikult ruttu veega maha jahutada ning seejärel pöörduda arsti poole. 
Materjali ei tohi naha küljest jõuga eemaldada.  

1.5.6 Kui sulanud materjal satub silma, tuleb see koheselt veega välja loputada ja 
pöörduda arsti poole.  

1.5.7 Keelatud on: 
1.5.7.1 muuta 3D-printeri seadistusi; 
1.5.7.2 lahti ühendada 3D-printeri juhtmeid;  
1.5.7.3 ilma raamatukoguhoidjata lisada liimi;  
1.5.7.4 ilma raamatukoguhoidjata vahetada filamenti. 

 
2 Graafikalaua kasutamine 

2.1 Graafikalaua kasutamiseks on vajalik osata kasutada graafikalaua nuppe ja pliiatsit 
ning seadistada graafikalauda.  

2.2 Raamatukogus kasutatakse erinevaid vabavaralisi programme (näiteks: Gimp, Krita, 
FireAlpaca). 

2.3 Graafikalaua nupud 
2.3.1 Riistvara juhtnupud (Hardware Control Buttons) graafikalaua parempoolses 

ülemises nurgas: 
2.3.1.1 Vasakpoolne juhtnupp kuvab kehtivate seadistuste skeemi. 
2.3.1.2 Keskmine juhtnupp avab ja sulgeb Wacom-i tahvli seadistused (Wacom 

Tablet Properties) (edaspidi tahvli seadistused). 
2.3.1.3 Parempoolne juhtnupp võimaldab nelja ülemist parempoolset 

väljundnuppu kasutada tavarežiimi (Normal Operation) asemel 
ekraanikuvas (On-Screen Display) ning vastupidi. 

2.3.2 Otseteenupud (Express Keys) asuvad graafikalaua vasak- ja parempoolsel 
raamil. Otseteenuppe saab seadistada täitma tihedamini kasutatavaid 
funktsioone. Otseteenuppe saab seadistada tahvli seadistuste all. 

2.3.3 Puuteribad (Touch Strip) graafikalaua vasak- ja parempoolse raami äärte all 
võimaldavad pildi mastaapi muuta ja pilti kerida. Näppu mööda puuteriba üles 
libistades saab pildist välja suumida või pilti üles kerida. Näppu mööda 
puuteriba alla libistades saab pildi sisse suumida või pilti alla kerida. Näppu 
puuteriba ala- või ülaosas hoides kerib pilt lakkamatult vastavalt alla või üles. 
Puuteribasid saab seadistada tahvli seadistuste all. 

2.4 Graafikalaua seadistamine 
2.4.1 Tahvli seadistuste avamiseks tuleb klõpsata keskmist riistvara juhtnuppu. 
2.4.2 Tahvli seadistuste all on võimalik määrata funktsioone graafikalaua nuppudele 

ja puuteribadele ning pliiatsi nuppudele ja otsale. 
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2.4.3 Funktsioonide määramiseks graafikalaua nuppudele tuleb tahvli seadistuste all 
valida Express Key Settings. Nuppudele saab soovitava funktsiooni valida 
rippmenüüst. Kõik muudatused jõustuvad koheselt. 

2.4.4 Funktsioonide määramiseks graafikalaua puuteribadele tuleb tahvli seadistuste 
all valida Touch Strip Settings. Puuteribale saab soovitava funktsiooni valida 
rippmenüüst. Kõik muudatused jõustuvad koheselt. 

2.4.5 Funktsioonide määramiseks pliiatsi nuppudele ja otsale tuleb tahvli seadistuste  
all valida Pen Settings. Nuppudele saab soovitava funktsiooni valida 
rippmenüüst. Kõik muudatused jõustuvad koheselt. 

2.5 Graafikalaua pliiatsi kasutamine 
2.5.1 Pliiatsit tuleb käes hoida nagu tavalist pastapliiatsit või harilikku pliiatsit. 

Nimetissõrm või pöial tuleb asetada pliiatsile nii, et külgnuppe oleks võimalik 
mugavalt kasutada, vajutamata samas neile kogemata. 

2.5.2 Pliiatsit saab kasutada graafikalaual joonistamiseks või kirjutamiseks. Pliiats on 
survetundlik, see tähendab, et mida tugevamalt sellega graafikalauale suruda, 
seda paksem ja tugevam tuleb joon. 

2.5.3 Kursori liigutamiseks ekraanil tuleb pliiatsit hoida seadme kohal, kuid seadet ei 
tohi puudutada. 

2.5.4 Topeltklõpsu (Double Click) tegemiseks tuleb ekraani pliiatsi otsaga kaks korda 
sama koha peal puudutada. 

2.5.5 Joone kustutamiseks tuleb pliiats tagurpidi kätte võtta ja „kustukummi“ 
(Eraser) liigutada selle ala peal, mida soovitakse kustutada. Funktsioon ei tööta 
kõigi arvutiprogrammidega. 

2.5.6 Objekti valimiseks tuleb ekraani pliiatsi otsaga puudutada üks kord. 
2.5.7 Objekti liigutamiseks tuleb objekt valida pliiatsi otsaga ning see pliiatsi otsa 

tõstmata liigutada soovitud kohale ekraanil. 
2.5.8 Pliiatsi seadistusi (pliiatsi otsa surve, „kustukummi“ surve jms) saab vaadata ja 

muuta tahvli seadistuste all. 
2.5.9 Külgnuppude kasutamiseks tuleb pliiatsit hoida graafikalaua ekraani kohal seda 

puudutamata. Külgnuppudele määratud funktsioone saab vaadata ja muuta 
tahvli seadistuste all. 

2.5.10 Graafikalaua kasutamisel ilma pliiatsita tuleb pliiatsit hoida selleks mõeldud 
alusel. Pliiatsit ei tohi asetada graafikalaua peale ega toetada nii, et pliiatsi 
otsale või „kustukummile“ on surve. 

2.5.11 Graafikalaua kasutamise lõpetamisel tuleb pliiats raamatukoguhoidjale 
tagastada. 

 
3 Hübriidkaamera kasutamine 

3.1 Hübriidkaamera kasutamiseks on vajalik teada, kus paikneb kaamera mälukaart ning 
eelnevalt läbi mõelda, kuhu (isiklik sülearvuti, mälupulk vm andmekandja) tehtud 
pildid salvestatakse ja kas on vajalik lisaks hübriidkaamerale ka raamatukogu arvuti 
kasutamine (selleks on vajalik arvuti eelnevalt broneerida).  

3.2 Hübriidkaameras on raamatukogu SD-kaart (mälukaart), millele võib kasutamise ajal 
pilte salvestada.  

3.2.1 Hübriidkaamera kasutaja võib kasutada pildistamiseks isiklikku SD-kaarti, millel 
on korrektne ühildumine hübriidkaameraga .  

3.2.2 Hübriidkaameraga koos antakse kasutamiseks micro USB kaabel piltide alla 
laadimiseks. Kasutaja võib kaabliga laadida pildid hümbriidkaamerast endale 
sobivale mäluseadmele.  

3.2.3 Hübriidkaamera on võimalik wifi kaudu ühendada kasutaja nutiseadmega. Wifi 
ühenduse kaudu piltide alla laadimiseks nutiseadmesse on vajalik rakendus 
Canon Camera Connect.  
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3.3 Hübriidkaamera SD-kaart asub kaamera alumisel küljel, aku kõrval. SD-kaarti ja akut 
kaitseb klapp, mis on nupust avatav.  

3.4 Peale kasutamist kohustub kasutaja raamatukogu mälukaardilt pildid kustutama. 
Raamatukogu SD-kaardile salvestatut ei varundata. Peale hübriidkaamera kasutaja 
lahkumist pildid kustutatakse raamatukoguhoidja poolt, kui kasutaja pole seda ise 
teinud.  

3.4.1 Hübriidkaamera SD-kaardile salvestatu saab kustutada hübriidkaamera menüü 
kaudu: menu – palyback settings – erase images.  

3.5 Hübriidkaamera tööle lülitamiseks asub kaamera paremal pool üleval on/off nupp. 
3.6 Hübriidkaamera objektiivi küljel olevat noolega nuppu lükates ja samal ajal objektiivi 

kergelt keerates aktiveeruvad kaamera ja objektiiv ning on pildistamiseks valmis.  
3.6.1 Hübriidkaamera objektiivilt tuleb eemaldada katik.  

3.7 Kaadrit saab suumida, keerates kergelt objektiivi paremale või vasakule.  
3.8 Fokusseerimiseks tuleb hoida pildistamise nuppu kergelt all. Kaamera piiksub kaks 

korda, kui kaader on fookuses.  
3.9 Pildi jäädvustamiseks tuleb pildistamise nupp täielikult alla vajutada.  

3.9.1 Hübriidkaameraga video filmimiseks on pildistamise nupu kõrval väike punase 
täpiga nupp. Nuppu tuleb vajutada filmimise alustamisel ja selle lõpetamisel.  

3.10 Hübriidkaameraga pildistamise või filmimise lõpetamisel tuleb see on/off nupust 
välja lülitada ja objektiiv katta katikuga.  

 
4 Kilelõikuri kasutamine 

4.1 Kilelõikuri kasutamiseks on vajalik läbi mõelda, kas soovite lõigata pilti või teksti, 
valida (vajadusel raamatukogust osta) sobiv materjal, osata kasutada tarkvarasid 
CutStudio ja CorelDRAW.  

4.2 Samaaegselt kilelõikuriga broneeritakse kasutajale innovatsioonilabori arvuti, kus on 
vajalikud tarkvarad CutStudio ja CorelDRAW.  

4.3 Arvutitarkvara CorelDRAW kasutamine 
4.3.1 Corel DRAW programmis kujundatakse töö (kavand).  
4.3.2 Arvutitarkvara CorelDRAW (edaspidi CorelDRAW) saab avada raamatukogu 

arvuti töölaual oleva ikooni kaudu. Enne CorelDRAW avamist tuleb avada 
CutStudio. 

4.3.3 CorelDRAW-s saab luua ise tekste ja pilte või salvestada soovitud pilt 
internetist. Tekst ja pilt peavad olema mustvalged ja soovitatavalt 
vektorgraafilised.  

4.3.4 Kui valitud pilt ei ole vektorgraafiline, tuleb pildi peal vajutada paremat 
hiireklahvi ning siis valida Quick Trace. 

4.3.5 Teksti või pildi väljalõikamiseks tuleb vajutada ülemise menüü R ikoonile, mis 
avab CutStudio ning saadab loodud faili sinna. 

4.3.6 Teksti või pildi lõikamiseks tuleb vajutada ülemise menüü ikoonil Cutting, 
seejärel tuleb avanevas kastis vajutada OK. CutStudio saadab väljalõigatava faili 
kilelõikurisse.  CutStudio kasutamist vt punktis 4.5 

4.4 Materjali paigaldamine kilelõikurisse 
4.4.1 Enne kile paigaldamist tuleb veenduda, et kilelõikuri taga vasakus nurgas asuv 

kang on langetatud alla. 
4.4.2 Kile tuleb paigaldada kilelõikurisse selle tagant poolt suunaga ette. Kui 

kasutatakse kilerulli, tuleb rull paigaldada selleks ette nähtud hoidikusse 
kilelõikuri jaluse küljes. Tuleb veenduda, et kile on paigaldatud sirgelt. 

4.4.3 Lõikepinna laius määratakse kindlaks kahe rullikuga, mis asuvad kile peal. 
Rullikud peavad jääma täielikult kile peale ja seadmel märgitud valgete alade 
alla.   
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4.4.4 Pärast lõikepinna suuruse määramist tuleb kile kilelõikuri külge kinnitada. 
Selleks on vaja tõsta üles kang kilelõikuri taga vasakus nurgas. Seejärel tuleb 
valida seadmel, kas kasutatakse kilerulli (Roll) või kiletükki (Piece) ning vajutada 
nuppu Enter. Kilelõikuri tera liigub vaikimisi alguspunkti. Sobiva alguspunkti 
määramiseks tuleb tera noolenuppudega liigutada ning siis vajutada ja hoida all 
nuppu Origin.  

4.4.5 Katsetamaks tera surve sobivust, on soovitatav enne lõiketööga alustamist teha 
testlõige. Selleks tuleb vajutada ja all hoida kilelõikuri nuppu Test. Kui kilelõikur 
on testlõike lõpetanud, tuleb noolenupuga kile masinast kaugemale liigutada, 
nokkimisnõela kasutades testkleeps eemaldada ning veenduda, et tera pole 
läbi kleep- või termokile alusmaterjali lõiganud ja kleebis eemaldub sellelt hästi. 
Kui tera surve pole sobiv, saab seda muuta, vajutades nuppu Force.  

4.5 Arvutitarkvara CutStudio kasutamine 
4.5.1 CutStudio programmiga valmistatakse töö (kavand) kilelõikuriga lõikamiseks 

ette.  
4.5.2 Arvutitarkvara CutStudio (edaspidi CutStudio) saab avada innovatsioonilabori 

arvuti töölaual oleva ikooni kaudu. 
4.5.3 Enne lõikamistöö alustamist tuleb valida programmi menüüst File -> Cutting 

Setup, seejärel avanevas aknas valida printerite rippmenüüst Roland GS-24. 
Soovides muuta töölaua suurust vastavalt kile suurusele, tuleb Media Size 
alammenüüs vajutada nupule Change... ja seejärel Get from Machine. 

4.5.4 Teksti lõikamiseks tuleb vajutada vasakpoolses menüüs A ikoonile, klõpsata 
valgel ruudustikualal ning trükkida tekst, mida soovitakse välja lõigata. 

4.5.5 Kui soovitakse pressida tekst või pilt riidele, siis tuleb asetada kujund 
peegelpilti. Selleks tuleb avada menüü Object ja sealt valida Mirror. 

4.5.6 Kujundi salvestamiseks tuleb vajutada ülemise menüü ikoonil Save. Avaneb 
aken, kus tuleb valida salvestuskoht ning anda failile nimi.  

4.5.7 Kujundi lõikamiseks tuleb vajutada ülemise menüü ikoonil Cutting, seejärel 
tuleb avanevas aknas vajutada nupule OK. CutStudio saadab väljalõigatava faili 
kilelõikurisse.  

4.6 Lõikuse katkestamiseks tuleb vajutada kilelõikuri nuppu Pause ning seejärel vajutada 
ja hoida all kilelõikuri nuppu Enter, mis tühistab lõikeprotsessi. 

4.7 Kui kilelõikur on lõikeprotsessi lõpetanud, võib kilelõikurist kleep- või termokile 
eemaldada. Selleks tuleb vajutada kilelõikuri nuppu Menu korduvalt, kuni kilelõikuri 
ekraanile ilmub tekst Unsetup, seejärel vajutada Enter. Lõiketera liigub algasendisse. 
Järgnevalt tuleb rullikud kile pealt ära lükata ning langetada kilelõikuri taga vasakus 
nurgas asuv kang alla. Seejärel võib kile kilelõikurist eemaldada. 

4.8 Kleebise saab aluspaberilt eemaldada nokkimisnõelaga. Nokkimisnõela saab 
raamatukoguhoidja käest.  

4.9 Põhjalik kilelõikuri kasutusjuhend on inglise keeles kättesaadav innovatsioonilabori 
arvuti töölaual. 

4.10 Tasu materjalikulu eest arvestatakse vastavalt hinnakirjale. 
4.11 Innovatsioonilaboris on kasutusel kuumpressikiled, mida saab kuumpressida 

puuvillale, linale, polüestrile ja nende segudele. Kiled ei sobi pressimiseks töödeldud 
ja värvitud riidele. 

4.12 Ohutusnõuded 
4.12.1 Kilelõikuri kasutamine on keelatud ilma eelneva raamatukogupoolse  

koolituseta. 
4.12.2 Keelatud on kilelõikuri peale toetuda, kuna kilelõikur ei kannata inimese 

raskust. Toetumise korral võivad kilelõikuri komponendid paigast nihkuda, 
mille tulemusel enam seadet kasutada ei saa, ning inimene võib libiseda või 
kukkuda ja viga saada. 
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4.12.3 Keelatud on kilelõikuri tera puutumine ning kilelõikuri puutumine siis, kui 
kilelõikur kilet lõikab. 

4.12.4 Kilelõikuriga töötades tuleb eemaldada kõik esemed (lips, kaelakee, rippuv 
riideeseme osa), mis võivad kilelõikuri külge kinni jääda. Samuti tuleb pikad 
juuksed seljataha kinni panna. 

4.12.5 Sädemete, suitsu, kärsalõhna, ebatavaliste helide või muu rikkele viitava korral 
tuleb kilelõikur vooluvõrgust koheselt eemaldada. Koheselt tuleb ka teavitada 
raamatukoguhoidjat.  

4.12.6 Kilelõikurisse võib paigaldada vaid selleks ettenähtud kleep- ja 
kuumpresskilesid. 

4.12.7 Kilelõikuri seadistusi ei tohi muuta ja  kilelõikuri juhtmeid lahti ühendada ilma 
raamatukoguhoidja juuresolekuta, välja arvatud punktis 4.12.5 mainitud 
juhtudel.  

 
5 Laserlõikepingi kasutamine 

5.1 Laserlõikepingi kasutamiseks on vajalik selgeks teha, kus asuvad laserlõikepingi ja 
jahutusseadme lülitid, hädaabilüliti ja mis on laserlõikepingil olevate nuppude 
funktsioonid ning osata kasutada tarkvara RDWorks.  

5.2 Arvutitarkvara RDWorks kasutamine 
5.2.1 Arvutitarkvara RDWorks (edaspidi RDWorks) saab avada laserlõikepingiga 

ühendatud arvuti (edaspidi arvuti) töölaual asuva ikooni kaudu. 
5.2.2 Faili importimiseks tuleb valida menüüst File->Import. Laserlõikamiseks sobivad 

eelkõige vektorgraafilised, graveerimiseks ka rastergraafilised failid. 
Importimisel on võimalik näha eelvaadet. NB! Ei sobi .svg faili formaat. 

5.2.3 Rastergraafilisi pilte saab muuta lõikamiseks sobivaks Bitmap Handle 
funktsionaalsuse abil (BMP ikoon menüüs). 

5.2.4 Joonestamise menüüst (Draw) või vasakpoolselt redigeerimisribalt saab valida 
erinevaid kujundeid ja kujundada teksti.  

5.2.5 RDWorks’i allääres asub objekti kihtide tööriistariba. Kihid on tähistatud 
erinevate värvidega ning nende parameetreid saab muuta paremal asuvas 
menüüs. Elemendi märgistamiseks uue kihina tuleb see selekteerida ja valida 
tööriistaribalt värv. 

5.2.6 Enne faili laserlõikepinki saatmist tuleb seadistada tarkvara parempoolses 
menüüs kihi parameetrid: kõige olulisemad on laserkiire liikumiskiirus ja laseri 
võimsus. Erinevatele materjalidele sobivaid parameetreid saab kontrollida 
innovatsioonilaboris asuvast tabelist. Samas saab muuta ka kihi töötlemisviisi: 
lõikamine (Cut),  graveerimine (Scan), täpistamine (Dotting), ning nende tööde 
järjestust kihtide alusel. Soovitatav on esmajärjekorras graveerida või täpistada 
ja seejärel lõigata.  

5.2.7 Eelvaatest (Edit->Preview) saab vaadata hinnanguliselt tööle kuluvat aega ning 
laserlõikamise protsessi simulatsiooni.  

5.2.8 Lõpetatud faili saab salvestada (File->Save) ning saata laserlõikepinki all 
paremal nurgas asuvast menüüst (Download). 

5.2.9 Põhjalik RDWorks’i  kasutusjuhend on inglise keeles kättesaadav 
innovatsioonilabori arvuti töölaual. 

5.3 Laserlõikepingi ja jahutusseadme lülitid 
5.3.1 Laserlõikepingi paremal küljel asub lülitite paneel. Kõige ülemine pöördnupp on 

pealüliti laserlõikepingi sisse ning välja lülitamiseks. Pealülitit päripäeva 
pöörates lülitub pink sisse ja vastupäeva keerates välja. Pealüliti all on 
lasertuubi voolu (Laser Switch) ja tööala valgustuse (Light Switch) lülitid. 
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5.3.2 Laserlõikepingi paremal küljel ülaservas asuvad kaks punast nuppu: „töölaud 
üles“ (Lifting Platform) ja „töölaud alla“ (Drop Platform), millega reguleeritakse 
töölaua kõrgust lõikepea suhtes. 

5.3.3 Laserlõikepingi esiosas asub digitaalne RuiDa kontrollpaneel, mille võimalusi on 
täpsemalt kirjeldatud punktis 5.4, ja punane hädaabi lüliti (Emergency Stop). 

5.3.4 Jahutusseadme lüliti asub seadme üleval paremas nurgas. 
5.4 Töö alustamine laserlõikepingis 

5.4.1 Enne töö alustamist tuleb kontrollida, et jahutusseade ja ventilatsioon 
töötavad. Jahutusseade tuleb kasutajal ise sisse lülitada, ventilatsioon lülitub 
laserlõikepingi kasutamisel sisse automaatselt.  

5.4.1.1 Jahutusseade asub laselõikepingi kõrval vasakul pool.  
5.4.2 Faili valimiseks tuleb kontrollpaneelil vajutada File nuppu. Avanenud menüüst 

saab valida faili, mis eelnevalt arvutist on laserlõikepinki saadetud. Fail valitakse 
nooltega ning valitud faili taust muutub siniseks. Valiku kinnitamiseks tuleb 
vajutada Enter. 

5.4.3 Noolenuppudega saab liigutada laseri lõikepea materjalil sobivasse punkti. 
Fookuskauguse paika panemiseks tuleb lõikepea ja materjali vahele asetada 
fokusseerimispulk ning liigutada töölauda üles või alla. Fookuskaugus on õige, 
kui fokusseerimispulk mahub lõikepea ja materjali vahele täpselt, kuid mitte 
liiga tihedalt. Tööfaili alguspunkti fikseerimiseks on kontrollpaneelil nupp 
Origin. Frame nupuga saab kontrollida tööfaili suurust ja selle paigutust 
materjalile.  

5.4.4 Kui kõik sobib, võib vajutada Start/Pause ning oodata töö valmimist. Nupu 
teistkordsel vajutamisel saab hetkel käimasoleva töö peatada. Vajutades nuppu 
uuesti saab tööd pooleliolnud kohast jätkata. 

5.5 Põhjalik laserlõikepingi kasutusjuhend on kättesaadav innovatsioonilabori arvuti 
töölaual. 

5.6 Ohutusnõuded 
5.6.1 Laserlõikepink on kõrgepingel töötav seade, mistõttu on see väga ohtlik. 

Laserlõikepingi kasutamine on keelatud ilma eelneva raamatukogupoolse 
koolituseta. 

5.6.2 Laserlõikepink kasutab IV klassi laserit, mille kiirgus võib põhjustada järgmisi 
õnnetusi: 

5.6.2.1 Laserkiir põletab kergesti süttivaid materjale. Kui laserlõikepingi 
töölaual materjal süttib, siis tuleb lülitada seade hädaabilülitist välja ning 
kasutada tule kustutamiseks tulekustutusvaipa või süsihappegaasiga 
tulekustutit, mis asuvad seadme vahetus läheduses. 

5.6.2.2 Erinevad lõikematerjalid võivad peegeldada ohtlikku kiirgust või eritada 
väga mürgiseid gaase laserlõikuse ajal.  Enne kaasavõetud materjalide 
töötlemist tuleb raamatukoguhoidjaga  kooskõlastada nende sobivus 
laserlõikamiseks või graveerimiseks. Töötlemiseks sobivad materjalid on 
kirjeldatud käskkirja punktis 5.6.3. Sulanud materjali mürgiseid gaase (kloor, 
tsüaniid jt) sisse hinganud inimene tuleb esimesel võimalusel viia värske õhu 
kätte, vajadusel konsulteerida arstiga.  

5.6.2.3 Laseri otsekiirgus kahjustab inimese silmi. Kohustuslik on kanda 
laserlõikuri töötamise ajal raamatukoguhoidja poolt antud kaitseprille.  

5.6.3 Laserlõikamiseks sobivad materjalid: akrüül, interjöörliimiga vineer, kartong, 
kloorivaba kumm, magnetleht, MDF (keskmise tihedusega puitkiudplaat), 
naturaalne nahk, paber, papp, riie, täispuit.  

Graveerimiseks sobivad materjalid: akrüül, anodeeritud alumiinium,  bambus, 
graniit, kartong, keraamika, klaas, kumm (kloorivaba), marmor, naturaalne nahk, 
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MDF, paber, papp, riie, interjöörliimiga vineer, metall, plastikud (v.a  ABS, HPDE, 
fiiberklaas, vahtpolüstüreen, POM, PVC, PC, süsinikkiud, vahtkumm). 

5.6.4 Laserlõikepingi töölaua kõrgust muutes tuleb veenduda, et Z-teljel poleks ees 
takistusi. 

5.6.5 Laserlõikepingi kaas peab olema laserlõikamise ja graveerimise ajal alati 
suletud. Lahtise kaanega töötamine on keelatud. 

5.6.6 Laserlõikepinki ei tohi jätta töötamise ajal järelevalveta. Laserlõikepingi 
kasutaja peab masina töötamise ajal olema laserlõikepingi juures ning seda 
jälgima. Ruumist lahkudes tuleb laserlõikepink välja lülitada.   

5.6.7 Laserlõikepingi jahutussüsteemi temperatuur võib olla maksimaalselt 30 
kraadi. Temperatuuri tõusmisel üle piiri, millest annab märku jahutusseadme 
alarm, tuleb lasta laserlõikepingil jahtuda.  

5.6.8 Laserlõikepingi luuke, mille kaudu pääseb seadme elektrooniliste 
komponentide ja lasertuubini, ei tohi avada. 

5.6.9 Laserlõikepingi ümbrust peab hoidma korras. Süttivaid ning plahvatusohtlikke 
materjale ei tohi hoida laserlõikepingi läheduses. 

 
6 Lõike- ja pressimismasina kasutamine 

6.1 Lõike- ja pressimismasina kasutamiseks on vajalik eelnevalt läbi mõelda, mida ja 
millisel eesmärgil soovitakse lõigata ning seejärel õppida masinat kasutama.  

6.2 Lõike- ja pressimismasin on mõeldud paberi ja kartongi lõikamiseks. 
6.3 Töö alustamiseks tuleb avada masina kummalgi küljel paiknevad platvormid. 
6.4 Kasutada võib kõiki lõike- ja pressimismasinatele mõeldud lõiketerasid ja 

tekstuurplaate. Lisaks olemasolevale valikule võib neid ka ise kaasa tuua. 
6.5 Lõike- või pressimistugevus tuleb seadistada vastavalt materjalile ning valitud 

lõiketeradele või tekstuurplaatidele. Seda saab teha masina ülaosas paiknevat ketast 
keerates. Esiküljel olev näidik skaalal 1-18 näitab vahe laiust, kust materjal läbi 
pressitakse. Kui lõikamine või pressimine tundub liiga raske, tuleb vahe laiust 
suurendada. Kui lõikamine või pressimine ei toimu piisava tugevusega, tuleb vahe 
laiust vähendada. Lõiketeraga lõikamisel on vahe laiuseks u 6-8, lõiketeraga 
surutrükil u 9-11, tekstuurplaadiga surutrükil u 13-15. 

6.6 Materjal tuleb paigaldada vastavalt valitud tegevusele:  
6.6.1 Lõiketeraga lõikamine: valge plaat, paber või kartong, lõiketera teraga 

allapoole, läbipaistev plaat; 
6.6.2 Surutrükk lõiketeraga: valge plaat, lõiketera teraga ülespoole, paber või 

kartong, silikoonmatt, läbipaistev plaat; 
6.6.3 Surutrükk tekstuurplaadiga: valge plaat, paber või kartong tekstuurplaatide 

vahel, läbipaistev plaat. 
6.7 Plaadid (vt 6.6.1) tuleb asetada platvormile ja ning masina küljel asuvat vänta 

keerates need selle keskel olevast vahest läbi pressida. 
6.8 Ohutusnõuded 

6.8.1 Lõike- ja pressimismasina kasutamine on keelatud ilma eelneva 
raamatukogupoolse koolituseta. 

6.8.2  Lõikamisel ja pressimisel tuleb masin paigutada nii, et see oleks piisavalt kaugel 
laua servast ega nihkuks vändates kohalt.  

 
7 Märgipressi kasutamine 

7.1 Märgipressi kasutamiseks on vajalik eelnevalt kujundada märk, kujundus välja 
printida ja see välja lõigata ning seejärel õppida märgipressi kasutama. 

7.2 Märgipressiga on võimalik teha ümmargusi rinnamärke läbimõõduga 37 mm. 
7.3 Märgi kujunduse võib printida või joonistada paberile (kui soovite kujundada ja 

printida märgi kujunduse raamatukogus, tuleb selleks arvuti eelnevalt broneerida). 
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Soovi korral on võimalik enne joonistamist markeerida sobiva suurusega ring 
šablooni abil, mille leiab ka raamatukogu veebilehelt. 

7.4 Märgipressi juurde kuuluva paberistantsiga saab ringi paberist välja lõigata. Selleks 
tuleb paber asetada alusplaadi ja auguga pealisplaadi vahele nii, et väljalõigatav ala 
jääb auguga kohakuti. Seejärel tuleb plaadid lükata paberistantsi ja tõmmata kang 
alla.  

7.5 Märgi pressimiseks tuleb märgipress paigutada lauale kangiga enda poole. 
7.6 Märgipressi A-vormi tuleb asetada kõigepealt märgitooriku ülemine osa, seejärel 

väljalõigatud kujundus ning viimasena kile, keerata vorm pressimisplaadiga kohakuti 
ja tõmmata kang alla. 

7.7 Märgipressi B-vormi tuleb asetada märgitooriku nõelaga tagumine osa nii, et nõel 
jääb allapoole, keerata vorm pressimisplaadiga kohakuti ja tõmmata kang 
ettevaatlikult alla. 

7.8 Ohutusnõuded 
7.8.1 Märgipressi ja selle juurde kuuluva ringilõikuri kasutamine on keelatud ilma 

eelneva raamatukogupoolse koolituseta. 
7.8.2  Lõikamisel ja pressimisel tuleb seadmed paigutada nii, et need oleksid piisavalt 

kaugel laua servast ega nihkuks kangi tõmmates kohalt. 
 
8 Termopressi kasutamine 

8.1 Termopressi kasutamiseks on eelnevalt vaja mõelda läbi, mida on soov riideesemele 
pressida ning millisele materjalile, seejärel vajalik õppida selgeks termopressi lülitite 
ja nuppude funktsioonid.  

8.2 Kui termopress pole kasutuses, on see välja lülitatud, vältimaks ettevaatamatusest 
tingitud õnnetusi, näiteks põletusi. 

8.3 Termopressi sisselülitamiseks tuleb tõsta termopressi kuumutusplaat käepidemest 
üles ning vajutada sisse/välja lülitist (ON/OFF Switch) sisse. 

8.4 Kui termopress on kuumenenud soovitud temperatuurini, tuleb riideese asetada 
pressile, asetada riideeseme peale küpsetuspaber ja lasta alla termopressi 
kuumutusplaat. Kuumutusplaati tohib liigutada vaid käepidemest. Kui 
kuumutusplaat on lukustatud, alustab automaatne taimer aja arvestamist. Vajadusel 
saab termopressi survet suurendada või vähendada, pöörates käepideme küljes 
olevat nuppu vastavalt päripäeva või vastupäeva. Kui kindlaks määratud aeg on kätte 
jõudnud, annab heli märku, et kuumutusplaat tuleb üles tõsta. Taimer lähtestab aja 
automaatselt ning pressitud riideeseme võib termopressilt eemaldada. 

8.5 Ohutusnõuded 
8.5.1 Termopressi kasutamine on keelatud ilma eelneva raamatukogupoolse 

koolituseta. 
8.5.2 Termopress töötab väga kõrgel temperatuuril (96°C kuni 221°C) ja kuuma 

termopressi puutumine tekitab tõsiseid põletusi. Termopressi soojenemise, 
pressimise ja jahtumise ajal ei tohi termopressi ülemist plaati puutuda (v.a 
käepidemest).  

8.5.3  Termopressiga võib riideesemetele pressida vaid selleks ettenähtud 
kuumpresskilesid. Riideeseme valikul konsulteeri eelnevalt raamatukogu-
hoidjaga.  

8.5.4 Termopressiga töötades tuleb eemaldada kõik esemed (lips, kaelakee, rippuv 
riideeseme osa jms), mis võivad termopressi vahele kinni jääda. Samuti tuleb 
pikad juuksed ohutult kinni panna. 

8.5.5 Keelatud on: 
8.5.5.1 Termopressi seadistusi muuta.  
8.5.5.2 Termopressi juhtmeid lahti ühendada.  
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9 Virtuaalse reaalsuse prillide kasutamine 
9.1 Virtuaalse reaalsuse prillide (edaspidi prillid) kasutamisel on oluline jälgida oma 

tervislikku seisundit kogu kasutuse kestel.   
9.2 Prille võib kasutada järjest 30 minutit. Peale 30 minutit tuleb teha prillide 

kasutamises paus. Kui ruumile, kus prille kasutatakse, ei ole järjekorda, võib 
pikendada kasutust üks kord 30 minutit.  

9.3 Prille võib kasutada alates 13. eluaastast, kui alaealisel on vanemalt saadud prillide 
kasutamise nõusolek (kirjalikult taasesitatavas vormis). Alla 13-aastased alaealised 
võivad kasutada prille lapsevanema juuresolekul ja vastutusel. Alla 13-aastane 
alaealised võib kasutada prille ka koos täiskasvanud saatjaga, kes ei ole tema vanem, 
kui täiskasvanud saatjal on kaasas alaealise vanema kirjalikult taasesitatavas vormis 
nõusolek.   

9.4 Prillid lülitatakse tööle paremal küljel asuvast nupust, mida tuleb paar sekundit all 
hoida.  

9.5 Prillid seadistab raamatukoguhoidja kasutajale mugavaks ja kinnitab kindlalt pea 
külge. Prillide juurde kuuluvad ka mõlemas käes hoitavad puldid.  

9.5.1 Läätsede seadistamine: prillidel on kolm seadistust läätsede paiknemiseks. 
Läätsede paiknemist saab muuta käega kergelt läätsi lükates paremale või 
vasakule. Kasutamiseks tuleb valida seadistus, mis tagab selge visuaali prille 
kasutades.  

9.5.2 Optilisi prille kandvad kasutajad saavad raamatukoguhoidjalt soovi korral 
prillide külge lisamiseks lisatarviku, mis annab lisaruumi optilistele prillidele 
virtuaalse reaalsuse prillide sees. 

9.5.3 Prillid kinnituvad pea külge horisontaalse ja vertikaalse rihmaga. Rihmasid tuleb 
kohendada nii, et prillid istuksid peas mugavalt. Vajadusel aitab rihmasid 
kohendada raamatukoguhoidja. 

9.5.4 Käes hoitavad puldid kinnitab raamatukoguhoidja turvakinnitusega käte külge, 
et need prille kasutades maha ei kukuks. 

9.6 Prille kandes tuleb kasutajal määratleda „Guardian“ ehk ala, mille sees prille 
kasutatakse.  

9.6.1 Kasutamise ala saab määratleda, joonistades käes hoitava puldiga põrandale 
virtuaalse joone, mille sees on turvaline liikuda. Nii saab kindlustada, et 
määratletud alal ei jää sisse mööblit ega muud liikumist takistavat.  

9.6.2 Prille kasutades ei tohi määratletud alast väljuda.  
9.6.2.1 Määratletud mängimise ala ei takista füüsiliselt alalt lahkumist, vaid 

teavitab visuaalselt, kui seda on tehtud.  
9.6.3 Prillide kasutamiseks määratletud alas ei tohi olla kõrvalisi objekte. 

Määratletud ala peab olema täiesti tühi ja võimaldama vaba liikumist.  
9.7 Prillide küljele käega koputades aktiveerub prillide väliskaamera ja prillide kasutajal 

on võimalik näha enda ümber toimuvat ilma prille eest ära võtmata.  
9.8 Sobiva kasutuse valimisel annab nõu raamatukoguhoidja.  
9.9 Prille ei tohi kasutada teatud meditsiinilistel põhjustel.  

9.9.1 Prillide kasutamine ei sobi rasedatele, vanuritele, südamehaigetele, 
fotosensitiivset epilepsiat põdevatele, nägemispuudega või vaimsete häiretega 
inimestele.  

9.10 Prillide kasutamine tuleb kasutajal koheselt peatada, kui ta tunneb ebamugavust.   
9.10.1 Prillide kasutamine võib kutsuda esile ootamatuid sümptomeid: krambid, 

silmade väsimus, lihastõmblused, kontrollimatud liigutused, nägemishäired, 
peapööritus, suunataju kadumine, tasakaaluhäired, koordinatsioonihäired, 
iiveldus, uimasus, väsimus, peavalu jne.  

9.10.1.1 Sümptomite ilmnemisel tuleb prillid koheselt eemaldada.  
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9.10.1.2 Sümptomid võivad kesta mõnda aega või ilmneda alles peale prillide 
kasutamist.  

9.10.2 Vajadusel pöörduda arsti poole.  
 

10 Printer-kilelõikuri kasutamine  
10.1 Printer-kilelõikurit saab kasutada pildi ja/või teksti printimiseks kleep- ja 

kuumpressikiledele ning selle väljalõikamiseks. 
10.2 Kleep- ja kuumpressikiled võib ise kaasa võtta või osta raamatukogust. Enne enda 

kaasavõetud materjalide kasutamist tuleb raamatukoguhoidja abiga veenduda, et 
need on printer-kilelõikurile sobilikud. Innovatsioonilaboris on kasutusel 
kuumpressikiled, mida saab kuumpressida puuvillale, linale, polüestrile ja nende 
segudele. Raamatukogus olemasolev termokile kuumpressitakse kangale 
temperatuuril 165°C 15 sekundi jooksul. Enda toodud kuumpressikilede ja kangaste 
puhul peab kasutaja olema enne veendunud selle kuumataluvuses. 

10.3 Printer-kilelõikur broneeritakse kasutajale koos arvutiga, milles on kujundustarkvara 
CorelDRAW ning printer-kilelõikuri tarkvarad Versaworks ja Roland DG OfflineUtility. 
Vajalik on nimetatud programmide kasutamise oskus. 

10.4 Arvutitarkvara CorelDRAW kasutamine. 
10.4.1 Arvutitarkvara CorelDRAW (edaspidi CorelDRAW) saab avada raamatukogu 

arvuti töölaual oleva ikooni kaudu. 
10.4.2 CorelDRAW’s kujundatakse pildi ja/või teksti kavand. Võimalik on ise tekste ja 

pilte luua või salvestada soovitud pilt internetist (koos lõikejoonega).  
10.4.3 Teksti või pildi väljalõikamiseks tuleb CorelDRAW’s määrata lõikejoon. Selleks 

tuleb: 
-  soovitud joon aktiveerida; 
- ekraani paremas servas VersaWorks värvipaletis valida paremat hiireklahvi 
vajutades roosa kastike (CutContour). 

10.4.4 Roosaks värvunud joon on lõikejoon, mille järgi printer-kilelõikur hakkab lõiget 
tegema. Vaikesättena on programmis lõikejoone paksus „hairline“, mis sobib 
enamike tööde teostamiseks.  

10.4.5 Printimiseks ja lõikamiseks valmis töö tuleb salvestada PDF-formaadis. Selleks 
avada ülemisest servast File -> Publish to PDF. Avanenud aknas on vaja muuta 
ära PDF preset, rippmenüüst valida PDF/X-1a:2001 ning seejärel salvestada. 

10.5 Kleep- või kuumpressikile paigaldamine printer-kilelõikurisse toimub ainult 
raamatukoguhoidja poolt. 

10.6 Printimine ja lõikamine 
10.6.1 Printimiseks ja lõikamiseks vajamineva tarkvara VersaWorks saab avada 

raamatukogu arvuti töölaual oleva ikooni kaudu. 
10.6.2 Samuti tuleb avada programm Roland DG OfflineUtility, kus saab näha 

printimise ja lõikamise protsessi (ülemises servas näitab pooleliolevat 
toimingut), liigutada lõiketera asukohta määramaks materjalil töö alguspunkti, 
näha tindi jääki ning valida eelnevalt kalibreeritud materjalide hulgast õige 
materjal. 

10.6.3 Ettevalmistatud PDF-fail tuleb lisada VersaWorks programmi tööde nimekirja 
(aken pealkirjaga Job List kukeroland). Seda saab teha kas valides ülemisest 
servast File -> Add Job to Queue või lohistades fail vastavale alale. 

10.6.4 Prinditavale/lõigatavale tööle tuleb määrata sätted, vajutades vasakul alumises 
nurgas olevale hammasratta ikoonile (Settings). Avaneb aken Job Settings, kus 
saab määrata kujunduse suurust, paigutust ja koopiate arvu. Sätteid muutes 
kuvab programm automaatselt, kuidas kujundus materjalile paigutub. 
CorelDRAW programmis määratud lõikejoont kuvatakse punktiirjoonena (kui 
selle asemel on pidev joon, prinditakse see joon lõikamise asemel – s.t joon 
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tuleks CorelDRAW programmis uuesti määrata). Kui kõik on õige, tuleb sätted 
salvestada vajutades all paremas nurgas olevat nuppu OK. 

10.6.5 Printimise alustamiseks vajutada VersaWorks ekraanil all vasakus nurgas 
printeri ikoonile. Avanenud aknas saab valida, mitu koopiat printida (kui see on 
juba sätete all seadistatud, siis ei pea enam midagi muutma). 

10.6.6 Kui töö on lõpetatud, saab selle ülejäänud materjalirulli küljest eemaldada, 
vajutades OfflineUtility programmis nuppu Sheet Cutting. Pärast töö lõpetamist 
tõsta alati üles seadme paremal poolel asuv kang, et vabastada kilerull ja tagada 
seadme seismisel masina rullikute ümarus. 

10.7 Põhjalik printer-kilelõikuri kasutusjuhend ja ohutusjuhend ning programmi 
VersaWorks kasutusjuhend on inglise keeles kättesaadavad innovatsioonilabori 
arvuti töölaual. 

10.8 Tasu materjalikulu eest arvestatakse vastavalt hinnakirjale. 
10.9 Ohutusnõuded 

10.9.1 Printer-kilelõikuri kasutamine on keelatud ilma eelneva 
raamatukogupoolse  koolituseta.  

10.9.2 Materjali on keelatud vahetada iseseisvalt, selleks palu abi 
raamatukoguhoidjalt. 

10.9.3 Keelatud on printer-kilelõikuri tera puutumine. Samuti on keelatud seadme 
töötamise ajal puutuda töös olevat materjali või avada luuke. 

10.9.4 Seadme kaitseklaas peab olema alati suletud, v.a kui toimub materjali 
vahetamine või seadme hooldus. Töö lõpetades tuleb alati üles tõsta kang, mis 
vabastab materjali ja aitab tagada seadme seismisel masina rullikute ümaruse. 

10.9.5 Keelatud on printer-kilelõikuri peale toetuda, kuna printer-kilelõikur ei kannata 
inimese raskust. Toetumise korral võivad printer-kilelõikuri komponendid 
paigast nihkuda, mille tulemusel enam seadet kasutada ei saa, ning inimene 
võib libiseda või kukkuda ja viga saada. 

10.9.6 Printer-kilelõikuriga töötades tuleb eemaldada kõik esemed (lips, kaelakee, 
rippuv riideeseme osa), mis võivad seadme vahele kinni jääda. Samuti tuleb 
pikad juuksed seljataha kinni panna. 

10.9.7 Sädemete, suitsu, kärsalõhna, ebatavaliste helide või muu rikkele viitava korral 
tuleb printer-kilelõikur vooluvõrgust koheselt eemaldada. Koheselt tuleb ka 
teavitada raamatukoguhoidjat.  

10.9.8 Printer-kilelõikuri seadistusi ei tohi muuta ja  selle juhtmeid lahti ühendada ilma 
raamatukoguhoidja juuresolekuta, välja arvatud punktis 10.9.7. mainitud 
juhtudel. 

 
 

 

 


